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1. PURPOSE

This procedure will describe how to measure the equilibrium constant, Kp, the
association rate constant, Ka, and the dissociation rate constant, Kd, of purified
proteins or peptides and their purified cognate monoclonal antibodies by
Surface Plasmon Resonance (SPR) Spectroscopy using a Biacore T200
instrument.

2. SCOPE

This procedure will describe sample preparation and operation of the Biacore
T200 using either a capture or amine coupling multiple cycle method to
measure affinity and kinetics parameters. This SOP includes a performance
gualification test that can be run to evaluate the performance of the Biacore
T200 instrument prior to evaluating test samples.

3. RESPONSIBILITIES

It is the responsibility of the person(s) performing this procedure to be familiar
with lab safety procedures and to have basic laboratory skills. It is the
responsibility of the analyst to follow the procedure steps as written and to
document any deviations, problems, and observations during an experiment in
their laboratory notebook.

4. EQUIPMENT

4.1. Biacore T200, Uppsala Sweden, Model #T200, Serial # 2650784
4.2. Fisher Vortex Genie 2

4.3. Eppendorf Mini Centrifuge Model 5154¢

4.4. Mettler AJ100 Analytical Balance

4.5. Rainin Pipet plus LTS Pipettor, adjustable 100-1000 pL

4.6. Rainin Pipet plus LTS Pipettor, adjustable 20-200 pL
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4.7. Rainin Pipet plus LTS Pipettor, adjustable 2-20 pL

4.8. Rainin Pipet plus LTS Pipettor, adjustable 0.1-2 uL

4.9. Reagentrack Type | (Cytiva rack included with instrument)

4.10. Reagent rack Type Il (Cytiva rack included with instrument)

4.11. Combined sample and reagent rack (Cytiva rack included with
instrument)

5. MATERIALS
5.1. Polypropylene microtiter u bottom 96 well plates (Greiner Bio One, Cat.
#650201)
5.2. Biacore Maintenance kit (Cytiva, Cat# BR1006-51)
5.3. Biacore Series S sensor CM5 chip (Cytiva, Cat# BR100530)
5.4. Series S sensor chip Protein A (Cytiva, Cat# 29127555)
5.5. 96 well microplate foils (Cytiva, Cat. #BR1005-78)
5.6. 7 mm (0.8 mL) plastic vials (Cytiva, Cat. #BR1002-12)

5.7. Penetrable Kraton™ G (SEBS) caps type 3 for 7 mm vials(Cytiva, Cat.
#BR1005-02)

5.8. 15 mm (4.0 mL) vials (Cytiva, Cat. # 29266981)

5.9. Penetrable Kraton™ G (SEBS) caps type 5 for 15 mm vials (Cytiva, Cat.
#BR1006-55)

5.10. Getting Started T200 kit: (Cytiva, Cat#. 28980886)

5.11. Amine coupling kit (Cytiva, Cat. #BR-1000-50)

5.12. Sodium Acetate Buffer pH 5.0 (Cytiva, Cat. #1003-50)

5.13. 10X HBS-EP+ buffer (Cytiva, Cat#. BR100826)

5.14. 5M Sodium Chloride (Quality Biological, Inc. Cat. #351-036-101)

5.15. Falcon BLUE MAX Jr. 15 ml Polypropylene Conical Tube

5.16. Falcon BLUE MAX Jr. 50 ml Polypropylene Conical Tube

5.17. Rainin Space Saver LTS Reloads Pipette Tips. 1000 pyL (Ranin, Cat.
#GPS-L10)

5.18. Rainin Space Saver LTS Reloads Pipette Tips. 250uL (Ranin, Cat.
#GPS-L250)

5.19. Rainin Space Saver LTS Reloads Pipette Tips. 20 uL (Ranin, Cat.
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5.20.

5.21.
5.22.

5.23.
5.24.
5.25.

5.26.
5.27.

) PROTEOMIC

#GPSL-1000)

Filter Unit 0.20 um porosity 500 mL (Nalgene, Cat. #
450-0020)

Filter Unit 0.22 um porosity, (Corning, Cat. #Cos430767)

Eppendorf Centrifuge Tubes, 1.5 ml (VWR, Cat. #20901-551 or
equivalent)

Polystyrene 10 mL pipettes, (FALCON, Cat. #356551)
Polystyrene 25 mL pipettes (FALCON, Cat. number #1BSPS25)
Surfactant —Amps 20 Tween 20 detergent 10% solution (Thermo
Scientific Cat. #28320)

H20, ultrapure deionized and 0.22 uM filtered

10 mM Glycine pH 1.5 (Cytiva, Cat # BR100354).

6. REAGENTS

6.1.
6.2.

Proteins or peptides corresponding to desired target
Monoclonal antibody or antibodies corresponding to desired cancer
related protein or peptide

7. PROCEDURE

7.1.

M-140.1

Preparation of Biacore T200 instrument

7.1.1. Switch on the instrument. The lamps on the front panel should light
in the following sequence: a) All the lamps light for a few seconds
and then go out. b) The green Ready lamp lights. c) The yellow
Temperature lamp flashes to indicate non-stabilized temperature,
and then is steadily lit when the temperature at the detection unit is
stable. The time required for temperature stabilization depends on
the set temperature and ambient temperature. The instrument uses
the last analysis and sample compartment temperatures set before
shutdown as default. Temperature stabilization should not take

more than an hour.
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7.2

M-140.1

7.1.2.

7.1.3.

7.1.4.

7.1.5.

Open the right pump compartment door and check that the clamp

of the peristaltic pump is properly fastened: the lever should be in

a vertical position.

Place a 2-liter bottle for waste solution on the waste and water tray.
Fit the cap carrying the waste tubes on to the bottle. Tighten the
tube fittings by hand. Always use a 2-liter bottle for waste. Fill a 500
ml bottle with ultrapure deionized, 0.22 um filtered water. Fit a cap
with gasket and place it on the waste bottle and into the water tray.
Insert the water tube into the water bottle.

Prepare fresh 500 mL of 1X HBS-EP+ buffer by diluting 50 mL of
10X buffer into 450 mL of ultrapure deionized, 0.22 um filtered
water in a 500 mL glass bottle. Mix well.

Prepare the instrument by inserting Tube A (from the instrument)
into the 500 mL of fresh 1x HBS-EP+. Make sure that the tube

reaches to the bottom of this buffer bottle.

Preparation for Instrument Performance Qualification

Note: The Performance Qualification should be run at least one time

per month to evaluate the T200 performance.

7.2.1.

Preparation of control protein

7.2.1.1. Take the Getting Started T200 kit out of the refrigerator to
warm to room temperature. The kit components
should be used within one week of opening (Date the
box after opening). Remove the anti-b2micro antibody
from the kit. Dilute 1 uL of the antibody (1 mg/mL) into 1
mL of 1X HBS-EP+ buffer for a final concentration of 1
ug/mL. Transfer 600 uL of diluted antibody (ligand) to a
0.8 mL (7 mm) polypropylene micro-vial and seal with a

cap. Label the vial appropriately.
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7.2.1.2. Start Biacore T200 Control Software by clicking on the
Start menu and select Biacore T200 Control Software
from the Biacore menu. The software establishes
connection with the instrument, which takes about 30
seconds.

7.2.1.3. Undock the maintenance sensor chip (obtained from the
Cytiva Maintenance Kit) and store it in a 50 mL conical
tube to keep it free of dust.

7.2.1.4. Insert a Series S Protein A sensor chip into the machine
and select Protein A in the description. Keep record of
the number of times the chip has been used. Discard the
chip after 800 cycles or after six months, whichever
comes first.

7.2.1.5. Prime the instrument with 1X HBS-EP+ buffer by
selecting Tools -> Prime. Follow the instructions in the
dialog boxes and start the procedure. When the
procedure is finished (after about 7 minutes), click on
Close. A continuous standby flow of running buffer is
started automatically when the procedure is finished.

7.2.1.6. Prepare the b2micro analyte (control protein) as follows.
In a 1.5 mL eppendorf tube, dilute 3.76 uL of b2micro
(8.5 uM) into 496.24 uL of 1X HBS-EP+ buffer for a final
concentration of 64 nM. Dilute 100 uL of 64 nM into 300
uL buffer to prepare a 4-fold dilution. Proceed with
additional 4-fold dilutions down to 0.25 nM.
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100 pL 100pL  100pL 100 pL
7.2.2. L E
C o C n C { .
64 16 a4 1 0.25
3.76 uL nM nM nM nM nM
B — 2 — microglobulin
496.24puL  300puL  300pL  300uL 300 pulL

Open the Biacore wizard file PQ_Wizard_01192021 that is
located in the path Share -> Instrumentation -> Biacore T200 ->
Protocols. The wizard should open showing the Injection
Sequence screen.

7.2.3. Verify the assay steps and settings:

7.2.3.1.
o
o
o

Injection sequence:

Detection flow path: 2-1.

Chip type: Protein A.

Ligand Capture is checked.
Regeneration is checked with 1 cycle.

7.2.3.2. Setup:

7.2.3.3.

M-140.1

Page 6 of 31

Startup: Check run startup cycles is checked
Solution: 1X HBS Buffer

Number of cycles: 3

Injection parameters:

Ligand capture:

% Ligand: Anti-2bmicro

+ Contact time: 60 (s)

% Flow rate: 10 (uL/min)

+«+ Stabilization period: 0 (s)
Sample:

« Contact time: 120 (s)

< Flow rate: 50 (uL/min)

+«+ Dissociation time: 180 (s)

2
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¢ Regeneration:
% Solution: 10 mM Glycine pH 1.5
« Contact time: 30 (s)
« Flow rate: 50 (uL/min)
+ Stabilization period: 0 (s)
7.2.3.4. Samples:

¢ Verify that the samples prepared match
according to the table seen below.

E PQ_Wizard_01192021 - Samples X ‘

Samples

Concentration | Concentration

Sample id MW (Da)
nM - pg/ml -

1 [b2mico 12000 0 0.000
2 |b2micro 12000 0.25 0.003000
3 |b2micro 12000 1 0.01200
4 |b2micro 12000 4 0.04800
5 |b2micro 12000 16 0.1920
& |b2micro 12000 64 0.7680
2 |bamico 12000 64 07680 .o
8

Run order
@ Asentered (O Increasing concentration

Help Control Samples... < Back Next > Close

7.2.3.5. System Preparations:

e Check prime before run
e Temperature settings:

= Analysis temperature — 25C

= Sample compartment temperature — 25C

7.2.3.6. Rack positions: The software will calculate the

minimum required volumes for each sample as
seen in the table below. Transfer at least the
minimum required volumes of samples and

buffers to 15 mM and 7 mm vials and seal with
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ventilated kraton G (SEBS) rubber, penetrable

caps. Verify that there are no bubbles in the vials.

Place the vials in the following positions on rack

as seen below.

i Kinetics/Affinity - Rack Positions

9::0::0
OQOOOD
. QQOO

O

X

R1A1
R1A2

158

b2micro

Sample

Sample 1
Conc (nM)

12000

R1A3

158

b2micro

Sample

12000

R1A4

158

b2micro

Sample

12000

R1AS

158

b2micro

Sample

12000

R1Ag

158

b2micro

Sample

12000

R1A7

158

b2micro

Sample

12000

R1B1

158

Buffer

Startup

96 Well Microplate

2Q00000Q00

R1B2

158

Buffer

Startup

R1B3

158

Buffer

Startup

R2 A1

970

Glycine pH 1.5

Regeneration

R2B1

290

Anti-2bmicro

Capture

< Back

Next >

Close

7.2.4. Click on next.

7.2.5. Complete Run Protocol steps.

7.2.6. Start the Run.

7.2.7. Document the run start time and estimated run time. The assay

should run for approximately two hours.

7.2.8.  When the run is complete, perform the data analysis as described

in section 7.5. Save the results from the Performance

Qualification (PQ) to the Shared Drive and document the run

appropriately in a laboratory notebook.
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7.2.9.

7.2.10.

) PROTEOMIC

If the Performance Qualification passes, proceed to analyze test
samples using the same Series S Protein A sensor chip using a
Capture Run in step 7.3 or using a new Series S CM5 sensor chip
using Amine Coupling in step 7.4. Place the instrument in stand-
by with 1X HBS buffer while preparing the test samples.

If this is the last experiment to be performed, eject the Series S
Protein A sensor chip. Take the chip insert out of the cassette and
submerge the chip insert in HBS-EP+ buffer in a 50 mL conical
tube and store at 4°C. Insert the Maintenance chip and run a
desorb operation. After the desorb operation, the instrument will
automatically start standby mode. Leave the system running in
ultrapure deionized H20. The Protein A chip can be used multiple
times. To re-use the chip, remove the chip insert from storage,
rinse with ultrapure deionized H20, and dry. Then put the chip
insert back into the cassette. Discard the chip after 800 cycles or

after six months, whichever comes first.

7.3. Preparation for Capture Run Using a Series S Protein A Sensor

M-140.1

Chip

Note: The following procedure could also be applied for the use of

the Series S Protein G Sensor Chip. In this case, select “Custom”

instead of selecting “Protein A” as chip type in the software.

7.3.1.
7.3.2.

7.3.3.

7.3.4.

Check buffer volumes and empty waste container.

Use the same Series S Protein A sensor chip that was used in the
QC.

Prime the instrument with 1X HBS-EP+ buffer by selecting Tools -
> Prime. Follow the instructions in the dialog boxes and start the
procedure. When the procedure is finished (after about 7
minutes), click on Close. A continuous standby flow of running
buffer is started automatically when the procedure is finished.
Preparation of the test sample.

Page 9 of 31
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7.3.4.1.

7.3.4.2.

Test
Protein

) PROTEOMIC

Remove the test sample antibody. Dilute the antibody
into 1 mL of 1X HBS-EP+ buffer to the optimum
concentration that was determined in assay development
tests or elsewhere. Please refer to Appendix A for
procedures to optimize ligand concentration.
Commonly used concentrations usually fall in the 5 — 25
ug/mL range. Transfer 600 uL of diluted antibody to a 0.8
mL polypropylene micro-vial and seal with a cap.

Prepare the test protein or peptide analyte at a
concentration range that is approximately 0.1X — 100X
the Kb of the binding interaction. If no knowledge of the
Kinetics is available, dilute test protein or peptide into 500
uL of 1X HBS-EP+ buffer for a final concentration of 1024
nM. Prepare 4-fold dilutions down to 1 nM as seen below.

100pL 100l 100 pL 100l 100 L

1024 256 64 16 4 1
nM nM nM nM nM nM

500uL  300pL 300 pL 300ul  300pul 300 pL

7.3.5. Open the Biacore method file T200_SOP_Method_Capture that is
located in the path Share -> Instrumentation -> Biacore T200 ->

Protocols. The method should open showing the Overview screen.

7.3.6. Click on General Settings and verify the following settings:

7.3.6.

7.3.6.

M-140.1

1. Atstart:

e Data collection rate: 10 Hz

e Detection: Dual

e Sample compartment temperature: 25°C
2. Miscellaneous settings:

e Concentration unit: nM

Page 10 of 31
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7.3.7. Click on Assay Steps.
7.3.7.1. Click on Startup in the middle of the panel.
e Assay step properties:
= Base Settings:
<> Name: Startup
< Purpose: Startup
X Connect to cycle type: Kinetics
= Assay step preparations:
s Temperature: 25C
% Buffer: A
= Number of replicates:
% Times: 3
% As entered: 1,2,3,1,2,3
7.3.7.2. Click on Sample in the middle of the panel.
e Assay step properties:
= Base Settings:
% Name: Sample
% Purpose: Sample
% Connect to cycle type: Kinetics
= Assay step preparations:
s Temperature: 25C
s Buffer: A
= Number of replicates:
% Times: 1
% Asentered: 1,2,3,1,2,3
7.3.8. Click on Cycle Types

7.3.8.1. Click on the Commands tab and verify the following
settings:

e Capture 1:
= Settings for Capture 1:
% Capture solution: Enter test antibody name
% Contact time: 60 seconds

M-140.1 Page 11 of 31
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% Flow rate: 10 uL/min
% Flow path: Second
e Sample 1:
= Settings for Sample 1:
% Type: High Performance
% Sample solution: Is Variable
% Contact time: 120 (s)
+« Dissociation time: 300 (s)
% Flow rate: 50 (uL/min)
% Flow path: Both
e Regeneration 1:
= Settings for Regeneration 1:
% Regeneration Solution: 10 mM Glycine pH 1.5
% Contact time: 30 (Ss)
% Flow rate: 50 (uL/min)
* Flow path: Both
7.3.9. Click on the Variable Settings.
7.3.9.1. Verify the following assay steps:
o Startup: Define all values in method
o Sample: Define all values at run time
7.3.10. Click on Setup Run.
7.3.10.1. Verify the Detection:
o Flow path: 2-1
o Click next
7.3.11. Edit the Variables Table accordingly. The listed concentrations
should match the concentrations that were prepared in 7.3.4.2.
7.3.11.1. Input the name of the test protein in the sample
solution column.
7.3.11.2. Input the molecular weight of the test protein in the
MW (Da) column.
Note: Always begin and end the titration with O

‘/@' l\’:\\\\\’ Sn\\ it‘:
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nM. Always repeat one concentration.
7.3.11.3. Click next

7.3.12. Check Prime before run under the System Preparations and click
Next. Do NOT check Normalize.

7.3.13. The software will calculate the minimum required volumes for
each sample as seen in the table below. Transfer at least the
minimum required volumes of samples and buffers to appropriate
vials and seal with ventilated kraton G (SEBS) rubber, penetrable
caps. Verify that there are no bubbles in the vials. Place the vials

in the following positions on rack as seen below.

T200_SOP_Method_Capture_Kinetics - Rack Pasitions ] X
Sample and Reagent Rack 1 v — Vo(llu‘nl;ne Content Type CS:;?:HI} s;‘la\l:l“(’ll;a }
OO =
g 8 8 O R1A2 158 test antigen Sample 1
R1A3 158 test antigen Sample 4
”O O R1A4 158 test ant:gen Sample 16
10 O O R1A5 158 test antigen Sample 64
O O OO O R1A6 158 test antigen Sample 256
7( :) R1A7 306 test antigen Sample 1024
O O R1B1 454 Buff; Start
10 O O R1D1 356 T:ste;ntibody Caapt::e
1O O OBO OO R1F1 1084 | Glycine pH 1.5 Regeneration
OO O
0O o O
'O O O O
@O0 OO0
QOO0 QQ
‘OO O
000 )
@ O OO ®
1] 1e(9]0)
A ] c D E E
Help Menu < Back Next > Close

7.3.14. Click on next.
7.3.15. Complete Run Protocol steps.

M-140.1 Page 13 of 31

/ &% NATIONAL
C ’?&CADF T@ANER
STITUT!

O
5 A HERS

'3'5 \\,\



http://proteomics.cancer.gov ) P ROT E Q M [ C

7.3.16.
7.3.17.
7.3.18.

7.3.19.

7.3.20.

7.3.21.

Start the Run.

Document the run start time and estimated run time.

When the run is complete, perform the data analysis as described
in section 7.5.

If additional experiments will be run using the antibody ligand and
protein analyte pair, place the instrument in stand-by with 1X HBS
buffer

If this is the last experiment to be performed, eject the Series S
Protein A sensor chip. Store the chip as described in 7.2.10. The
Protein A chip can be used multiple times. Discard the chip after
800 cycles or after six months, whichever comes first.

Insert the Maintenance chip and run a desorb operation. Leave
the system running in ultrapure deionized, 0.22 um filtered water.
Prior to re-use, rinse the chip with deionized water and carefully
dry the raised glass side. Slide the chip insert back into the
cassette. Discard the chip after 800 cycles or after six months,

whichever comes first.

7.4. Preparation for an Amine Coupling Immobilization Run Using a
Series S CM5 Chip

Note: It is recommended to use amine coupling if it is known that

M-140.1

the interaction between the antibody and test analyte shows very

tight binding (low pM binding).

7.4.1.
7.4.2.

Check buffer volumes and empty waste container.

Preparation for covalent immobilization.

7.4.2.1 Remove the Amine Coupling Kit from 2 - 8°C. If the kit
has already been prepared, skip to 7.4.3. The kit
contains:
7.4.2.1.1.  N-Hydroxysuccinimide (NHS),115 mg

Page 14 of 31
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7.4.3.

7.4.4.

7.4.5.

7.4.2.2.

7.4.2.3.

7.4.2.4.

7.4.2.5.

) PROTEOMIC

7.4.2.1.2. 1-Ethyl-3-(3-
dimethylaminopropyl)carbodiimide
hydrochloride (EDC), 750 mg

7.4.2.1.3. 1M Ethanolaminehydrochloride-NaOH pH
8.5,10.5mL

Dissolve the EDC and NHS by adding 10.0 mL of

filtered, deionized water to each vial.

Cap vials tightly and vortex until the solids are

completely dissolved.

Prepare separate 500 uL aliquots of the EDC and NHS

solutions for storage.

Store the aliquots of EDC and NHS frozen at -18°C or

below. Ethanolamine may be stored at 2°C to 8°C.

Undock the maintenance sensor chip or the Protein A chip from

the PQ and store it in a 50 mL conical tube as described in

7.2.10.

Insert a new Series S CM5 chip into the machine and select CM5

in the description. Each CM5 chip has 4 flow cells. After an

antibody is immobilized via covalent bonding to one flow cell, it

cannot be removed. Therefore, one CM5 chip could potentially

have three different antibodies immobilized on it (Flow cell one

must always be used as a reference). If only flow cells one (Fcl)

and two (Fc2) are utilized in an assay, flow cells three and four

(Fc3 and Fc4) on the same chip could be used to immobilize two

new antibodies in a separate assay.

Prime the instrument with 1X HBS-EP+ buffer by selecting Tools

-> Prime. Follow the instructions in the dialog boxes and start the

procedure. When the procedure is finished (after about 7

minutes), click on Close. A continuous standby flow of running

buffer is started automatically when the procedure is finished.
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7.4.6.

7.4.7.

7.4.8.

7.3.9.
7.4.10.

M-140.1
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Prepare the following for the immobilization of two flow cell
surfaces: EDC (500 uL), NHS (500 uL), two blank tubes for
mixing EDC/NHS and ethanolamine (1.0 mL).
Remove the test sample antibody. Dilute the antibody into 1 mL
of the pre-conditioning buffer 10 mM sodium acetate buffer, pH
5.0, to the optimum antibody concentration that was determined
in assay development tests. Commonly used concentrations
usually fall in the 5 — 25 ug/mL range. Mix well. Transfer 200 uL
of diluted antibody to a 0.8 mL polypropylene micro-vial and seal
with a cap. See Appendix A for procedures to optimize pre-
concentration pH and ligand concentration.
Within the Biacore T200 Control software, select File and
Open/New Wizard Template. Browse to the
SOP_Method_Amine_Coupling_Immobilization_01152021
template located within the Shared Drive.
Share -> Instrumentation -> Biacore T200 -> Protocols
Verify the Chip Type — CM5 and flow cells per cycle — 1.
Check boxes for Flow cell 1 (Fc 1) and Flow cell 2 (Fc 2). Select
‘Blank immobilization” for Fc 1. For Fc 2, type the name of the
test antibody for the ligand name.
7.4.10.1. Select Aim for Immobilized Level if you don’t know

the contact time.

= Calculate the target level response units (RU)
using the following formula:
RL = (Rmax* MWL)/(MRa * Valency.)
Where Rmax = 30
= Use 50 nM NaOH for the wash solution.

7.4.10.2. Select Specify Contact time and Flow rate when

following a protocol that specifies the contact time
7.4.10.3. Click Next.
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7.4.11. Check the box for Prime.. Do not check box for Normalize. Leave
temperature settings as they are. Click Next.

7.4.12. The wizard will calculate the minimum required volumes and
indicate the vial positions. Place your reagents, ensuring
adequate volumes, in the appropriate positions and click next.
Don't forget the empty tubes for mixing the EDC/NHS. Note the

estimated run time (approximately 1.0 hour).

E SOP_Method_Amine_Coupling_Immobilization 01152021 - Rack Pesitions O X
Reagent Rack 2 Position V"(I::I';'e Content Type
| o=

R2B2 89:NHS Immob Fc 1

R2B3 Empty: EDC/NHS, min. capacity 124l Immob Fc 1

R2B4 129: Ethanolamine Immob Fc 1
R2C1 89 EDC Immob Fc2
R2C2 89 NHS Immob Fc2
R2C3 Empty: EDC/NHS, min. capacity 124yl “Immob Fc2
R2C4 129: Ethanolamine Immob Fc2

R2 C5 98 TestAntibody | Immob Fc2

None

Help Menu ¥ < Back Next > Close

7.4.13. Save this immobilization file before running this wizard to the

appropriate project folder located in the Biacore T200 instrument
folder on the Shared Drive.

7.4.14. Start the immobilization.

7.4.15. Remove the test protein or peptide analyte from 4°C, -30°C, or -
80°C

7.4.16. Dilute the protein or peptide test analyte to a concentration range
that is approximately 0.1X — 100X the Kp of the binding
interaction. If no knowledge of the kinetics is available, dilute

_/ % MAJIONA
é Q NS U
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test protein into 500 uL of 1X HBS-EP+ buffer for a final
concentration of 1024 nM. Prepare 4-fold dilutions down to 1 nM

as seen below.

100 pL 100 pL 100 pL rloou\Lrloou\L

1024 256 64 16 a4 1
Test nM nM nM nM nM nMm

Protein

500 pL 300 puL 300 pL 300 pL 300 pL 300 pL

7.4.17. When the immobilization is finished, open the
T200_SOP_Direct_Kinetics method. The method should open
with the Overview screen.

7.4.18. Click on General Settings and verify the following settings:
7.4.18.1. Atstart:

e Data collection rate: 10 Hz
e Detection: Dual
e Sample compartment temperature: 25°C
7.4.18.2. Miscellaneous settings:
e Concentration unit: nM
7.4.19. Click on Assay Steps.
7.4.19.1. Click on Startup in the middle of the panel.
e Assay step properties:
. Base Settings:
« Name: Startup
« Purpose: Startup
+ Connect to cycle type: Kinetics
=  Assay step preparations:

«» Temperature: 25C

M-140.1 Page 18 of 31
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< Buffer: A

Number of replicates:

s Times: 3

% Asentered: 1,2,3,1,2,3

7.4.19.2. Click on Sample in the middle of the panel.

Assay step properties:

Base Settings:

X/

« Name: Sample

X/

< Purpose: Sample

« Connect to cycle type: Kinetics
Assay step preparations:

s Temperature: 25C

s Buffer: A

Number of replicates:

s Times: 1

s Asentered: 1,2,3,1,2,3

7.4.20. Click on Cycle Types

7.6.1.1.

settings:

Click on the Commands tab and verify the following

e Sample 1:

M-140.1

Settings for Sample 1.:

% Type: High Performance

% Sample solution: Is Variable
+ Contact time: 120 (s)

++ Dissociation time: 300 (s)

< Flow rate: 50 (uL/min)

% Flow path: Both
Regeneration 1:

Settings for Regeneration 1:

Page 19 of 31
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7.4.21.

7.4.22.

7.4.23.

7.4.24.

M-140.1
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% Regeneration Solution: 10 mM Glycine
pH 1.5
« Contact time: 30 (s)
« Flow rate: 50 (uL/min)
. Flow path: Both
Click on Setup Run.
7.4.21.1. Select the Detection flowpath: 2-1. Click Next.
Edit the Variables Table according to the name of the test protein
or peptide analyte:
7.4.22.1. Input the name of the test protein or peptide analyte.
Input the molecular weight of the test protein or
peptide analyte in the MW (Da) column. The listed
concentrations should match the concentrations that
were prepared in 7.4.16. Note: Always begin and
end the titration with 0 nM. Always repeat one
concentration.
7.4.22.2. Click next.
Check Prime before run under the System Preparations and click
Next. Do NOT check Normalize.
The software will calculate the minimum required volumes for
each sample as seen in the table below. Transfer at least the
minimum required volumes of samples and buffers to appropriate
vials and seal with ventilated kraton G (SEBS) rubber, penetrable
caps. Verify that there are no bubbles in the vials. Place the vials

in the following positions on rack as seen below.
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7.4.25.
7.4.26.
7.4.27.
7.4.28.
7.4.29.

7.4.30.

7.4.31.

ETZOO SOP_Direct_Kinetics - Rack Positions O X
Reagent Rack 2 Position CS:::'(.:PII)
QO R1A1 158 Test Analyte Sample i]
i R1A2 158 Test Analyte Sample 1
R1A3 158 Test Analyte Sample -
040 O4O R1A4 158 Test Analyte Sample 16
R1AS 158 Test Analyte Sample 64
R1 A6 158 Test Analyte Sample 256
1 R1A7 158 Test Analyte Sample 1024
R1A8 158 Test Analyte Sample 1024
R1A% 158 Test Analyte Sample 0
96 Well Microplate R1B1 158 Buffer Startup
R1B2 158 Buffer Startup
R1B3 158 Buffer Startup
“ 8 8 8 8 8 8 8 8 R2 A1 1084 Regen Buffer Regeneration
"
2QOO00000
Q0000000
:QOO0O0O000
101010/01010]0]0)
sQOOOOO00
:00000000
QOOOO0O0O0
: 00000000
:0Q000000
QOeCOO0O00
A B C D E F G H
Help Menu W < Back Next > Close

Click on next.

Complete the Prepare Run Protocol steps.

Start the Run.

Document the run start time and estimated run time.

When the run is complete, perform the data analysis as
described in section 7.5.

If additional experiments will be run using the antibody ligand
and protein antigen pair, place the instrument in stand-by with 1X
HBS buffer.

If this is the last experiment to be performed, eject the Series S
CMS5 chip. Label a 50 mL conical tube with the
antibody/protein/peptide pair and the project name. Store the
chip as described in 7.3.21. Insert the Maintenance chip and run

a desorb operation. Leave the system running in deionized, 0.22
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um filtered water. Shut down the instrument if it will be

unattended for more than two weeks.

Data Analysis

7.5.1.

7.5.2.

7.5.3.

7.5.4.

7.5.5.
7.5.6.

7.5.7.

7.5.8.

7.5.9.

7.5.10.

7.5.11.
7.5.12.

The Evaluation software should open automatically at the end of
any run with the current data loaded. If data is to be analyzed
later, open the Biacore T200 Evaluation Software 3.2. Select
File -> Open and browse to the appropriate project folder where
the run was saved.

Look across the top menu toward the right side and select
Screening, Kinetic screen.

Multiple result files can be included in one analysis. For the PQ
data analysis, there is one result file. Click Next.

Thumbnail(s) will appear on the left, and the detailed
sensorgram with reference subtracted and blank subtracted
sample responses appears on the right. The 0 nM concentration
sample has been subtracted from the other curves. View the
blank.

Above the thumbnail, choose View, Extended thumbnails.
Above the thumbnail, click on Settings, Fit Settings. Choose the
1:1 model. Click ok. Now click Fit.

Choose the blank injection which is be the cycle just before the
checked cycle on the left-hand side and click Next.

The data will now be flow cell referenced and buffer subtracted,
hence double referenced. Choose kinetics and click Next.

Using the 1:1 binding model, click Fit. Click Next.

The data is then iteratively processed.

Examine the Quality Control results. All QC results should pass.
Examine the Report results. The association rate constant (ka),
the dissociation rate constant (kd), the equilibrium constant (Kp),
the Rmax, and the Chi? will all be calculated.
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7.5.13.
7.5.14.
7.5.15.
7.5.16.
7.5.17.

7.5.18.
7.5.19.
7.5.20.

7.5.21.

) PROTEOMIC

For the PQ to pass, the Ko must be 1 nM +/- 0.2.

The Rmax must be < 100 RU. Less is better.

The Chi? must be < 5% of Rmax

The U-value must be < 15.

Click on the Residuals button. Ideally, the residuals will scatter
randomly around zero over a range that corresponds to the
short-term noise in the detection system (approximately +1 to 2
RU).

Perform a similar analysis for Test Antibody and Test Protein.
Select the best model that fits the data.

Document the association rate constant (ka), the dissociation
rate constant (kd), the equilibrium constant (Kp), the Rmax, and
the Chi? results for the monoclonal antibody and protein antigen
pair in a laboratory notebook.

Save the data to the appropriate folder in the Shared Drive.

8.0. MAINTENANCE

M-140.1

8.1. Daily maintenance (Excluding weekends/holidays)

8.1.1.
8.1.2.
8.1.3.
8.1.4.
8.1.5.
8.1.6.

8.1.7.

Prepare fresh buffer if the buffer bottle volume is low.
Change the ultrapure deionized, 0.22 um filtered water.
Check and empty the waste bottle.

Prime 1X to flush the system.

Prime 3X when switching buffers and chips.

Leave the instrument in Tools: Standby mode between
experiments. Use ultrapure deionized, 0.22 um filtered water.
If you intend to leave the instrument idle for more than two
weeks, shut down the instrument by choosing Tools:
Shutdown.

8.2. Weekly maintenance

8.2.1.

Clean the liquid handling system by running Desorb.

W &rSyelii
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8.3. Monthly maintenance

8.3.1.
8.3.2.

8.3.3.

8.3.4.

Clean the instrument cover.

Clean and disinfect the flow system (Desorb and
Sanitize).Inspect the sample compartment, look for signs of
flooding.

Check tubing connections and syringe pumps for leaks. If leaks

are found, contact optirunservice.na@cytiva.com with the

instrument and serial # to schedule service.
Run System Check if something is wrong with the instrument,
i.e., lack of injections, delayed injections, or noisy data, contact

optirunservice.na@-cytiva.com with the instrument and serial #

to schedule service.

9. REFERENCED DOCUMENTS

9.1.
9.2.
9.3.
9.4.
9.5.

Biacore T200 Instrument Handbook
Biacore T200 Software Handbook
Biacore T200 Getting Started
Anti-Micro Kinetics Affinity PQ manual

Amine Coupling Kit Manual

10.APPENDIX A

10.1.Ligand Concentration Optimization for Protein A Sensor Chip

M-140.1

10.1.1.
10.1.2.

10.1.3.

Check buffer volumes and empty waste container.

Use the same Series S Protein A sensor chip that was used in
the QC.

Prime the instrument with 1X HBS-EP+ buffer by selecting Tools
-> Prime. Follow the instructions in the dialog boxes and start

the procedure. When the procedure is finished (after about 7
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10.1.4.

10.1.5.

10.1.6.

10.1.7.
10.1.8.

minutes), click on Close. A continuous standby flow of running
buffer is started automatically when the procedure is finished.
Remove the test sample antibody. Dilute the antibody

into 200 uL of 1X HBS-EP+ buffer to 1 ug/mL, 5 ug/mL, 10
ug/mL, and 20 ug/mL. Transfer 200 uL of the diluted antibodies
to 4 x 0.8 mL polypropylene micro-vials and seal with a cap.
Add 500 uL of 10 mM Glycine pH 1.5 to a 0.8 mL polypropylene
micro-vial and seal with a cap.

Based upon the molecular weight of the ligand antibody and
analyte, determine the ideal immobilization level for a desired
Rmax of about 30 response units (RU) using the following link:

surface density calculator | Cytiva (cytivalifesciences.com).

Open the Biacore T200 Control Software.

Select Run -> Manual Run to start a manual run.

& Manual Run g|

Flaw Reagent Rack 2

’? Flow rate: [l | [ul/min) SO Oggo
Flow path EO OO@O

Reference
Dietection in fow celllz] 1,234 subtraction; IQ QO(OQ
O E Flaws path 1 () E Flaws path 1-2

384 well Microplate
(@) E\ Flaw path 2 (@) @ Flaws path 3-4

23
i E\ Flowa path 3 ® Flow path 1-2-3-4 | 21.4-3 hd 22

I N Y

ABCOEFGHI JEKLMHNOR

[ Help ] [ Eject Rack ] Start ” Close

10.1.9. Select Flow path 1.
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10.1.10. Click Eject Rack to eject the rack tray so that you can load your
samples.

10.1.11. Load the samples in the appropriate positions in the rack.
Note: Document the rack positions and volumes of samples
that you prepare. There is no software support in manual
run for identifying samples or monitoring the volume of
liquid in the autosampler position.

10.1.12.Click Start to start the run. Specify a result file name before the
run actually starts.

10.1.13. Control the manual run from the command buttons in the main
window or the options in the Command menu.

10.1.14. Use the command buttons as seen below:

 Biacore T100 Control Softwar

(0] File  Edit  Wiew  Commands

Bl rls
Command __ |F&i# »13 @JzJ
) 3
buttons e » il
q=

10.1.15. Select the injection command. Choose the 1 ug/mL position
from which the sample will be taken and specify a contact time
of 60 seconds. The required volume for the specified contact
time is indicated in the dialog box. Examine the slope and the
final capture level.

10.1.16. Select the regeneration command. Choose the position from
which the 10 mM Glycine pH 1.5 will be taken and specify a
contact time of 30 seconds. Make sure that the chosen position
contains enough solution for the injection. The required volume

for the specified contact time is indicated in the dialog box.

M-140.1 Page 26 of 31
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10.1.17.Repeat steps 10.1.15. and 10.1.16. for 5 ug/mL, 10 ug/mL, and

20 ug/mL.

10.1.18. Based upon the final capture level for each concentration, select

the concentration that achieves an immobilization closest to the
target response units (RU) calculated in step 10.1.6. If
necessary, the injection time can also be adjusted to fine tune

the immobilization level in order to reach the target RU.

Note: The following sections 10.2 and 10.3 are not required for

optimization of ligand concentration on the Protein A sensor chip. They

only apply to immobilization optimization on the CM5 chip.

10.2.Immobilization pH Scouting

M-140.1

10.2.1.
10.2.2.

10.2.3.

10.2.4.

10.2.5.

Check buffer volumes and empty waste container.

Insert a new Series S CM5 chip into the machine and select
CMS5 in the description.

Prime the instrument with 1X HBS-EP+ buffer by selecting Tools
-> Prime. Follow the instructions in the dialog boxes and start
the procedure. When the procedure is finished (after about 7
minutes), click on Close. A continuous standby flow of running
buffer is started automatically when the procedure is finished.
Remove the test sample antibody. Dilute the antibody to the
appropriate single concentration to be tested (i.e. 5 ug/mL) into
100 uL for each of the pre-conditioning buffers 10 mM sodium
acetate buffer, pH 4.0, pH 4.5, pH 5.0, and pH 5.5. Mix well.
Transfer 100 uL of each pH solution into a 0.8 mL polypropylene
micro-vial and seal with a cap.

Add 200 uL of 50 mM NaOH to a 0.8 mL polypropylene micro-

vial and seal with a cap.
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10.2.6. Within the Biacore T200 Control software, select File and
Open/New Wizard Template. Select Immobilization pH
Scouting under the Surface Preparation folder.

10.2.7. Click on new.

10.2.8. Verify the settings below and click next.

ﬁ Immobilization pH Scouting - Setup

Detection
Flow path: 1 v

Buffers

Buffer Name
10 mM Acetate
10 mM Acetate

10 mM Acetate
10 mM Acetate

10.2.9. Enter the appropriate name of the test antibody and
concentration. Click next.

ﬁ Immobilization pH Scouting - Injection Parameters X

Ligand
Solution: | Test Antiboc| |
Contact time: )  Fowrate: (1d/min)

Surface regeneration
This suface wash will be run once at the end of each cycle.

Sohtion: | 50mM NaOH |

| M || <Back | Net> || Cose |

M-140.1 Page 28 of 31
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10.2.10. Select “Prime before Run” and click “Next”.
10.2.11. The software will calculate the minimum required volumes for
the run. Prepare the Reagent Rack 1 as seen below making

sure to place the vials in the appropriate positions. Click next.

il
Sample and Reagent Rack 1 v s —
R1A2 43 TestAntibody Sample 10 mM Acetate 5
O O O O O R1A3 43 TestAntibody Sample 10 mM Acetate 4.5
O R1A4 43 TestAntibody Sample 10 mM Acetate 4

O O O R1B1 198 50mM NaOH Regeneration
995950)
CO00K )
000,

olole %@
rolele O.©

O OO0 OO

0 O O
'.OOC>C><>

3388000
0000 ()

A B c D

Help Menu ¥ < Back Next > Close

10.2.12. Verify the Run Protocol final settings and click Run.
10.2.13. Data Analysis
10.2.13.1. When the wizard run is completed, the results are
opened automatically in the Evaluation Software,
with an overlay plot of the sensorgrams adjusted to
the start of the sample injection.
10.2.13.2. Choose the optimum buffer pH based upon the
binding behavior: at pH suitable for immobilization,
the ligand binds rapidly to the surface during the
injection and dissociates completely after the end of
the injection. The optimum pH is generally the
highest pH value (i.e. the mildest condition) that
gives sufficient ligand binding closest to the

_/ 2 I\‘\‘\\l
FR
é Q |N fiRitin

Page 29 of 31



PROTEOMIC

http://proteomics.cancer.gov )

calculated RL, not necessarily the value that gives
the highest ligand binding. Beware of conditions that
give irregular sensorgrams with incomplete
dissociation: this behavior often indicates
aggregation or denaturation of the ligand. Use this
pH to select the optimum concentration, see
Appendix A, Section 10.3.

10.3.Ligand Concentration Optimization on the Series S CM5 Sensor

10.3.1. Check buffer volumes and empty waste container.

10.3.2. Use the same Series S CM5 chip that was used for pH scouting.

10.3.3. Remove the test sample antibody. Dilute the antibody to 5
ug/mL and 20 ug/mL each in the pre-conditioning buffer that
was determined from pH Scouting (i.e. 10 mM sodium acetate
buffer, pH 5.0). Mix well. Transfer 200 uL of each antibody
concentration to a 0.8 mL polypropylene micro-vial and seal with
a cap.

10.3.4. Determine the ideal immobilization level for a desired Rmax Of
about 30 response units (RU) using the following link: surface
density calculator | Cytiva (cytivalifesciences.com)

10.3.5. Within the Biacore T200 Control software, select File and
Open/New Wizard Template. Select Immobilization pH
Scouting under the Surface Preparation folder.

10.3.6. Click on new.

10.3.7. Verify the settings below and click next.
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D Immobilization pH Scouting - Setup X

Detection
Flow path: 2 v

Buffers

Buffer Name pH
1 Test Ab 5 ug/mL 5
2 Test Ab 20 ug/mL 5

Help Next > Close

10.3.8. Input the name of the Test Antibody. Click next.
10.3.9. Select prime. Click next.
10.3.10. The software will calculate the minimum required volumes for
the run. Prepare the Reagent Rack 1 making sure to place the
vials in the appropriate positions. Click next.
10.3.11. Verify the Run Protocol final settings and click Run.
10.3.12. Data Analysis
10.3.12.1. When the wizard run is completed, the results are
opened automatically in the Evaluation Software,
with an overlay plot of the sensorgrams adjusted to
the start of the sample injection.

10.3.12.2. Choose the optimum concentration based upon the
ideal immobilization level that was calculated in
section 10.3.4. to achieve an Rmax of 30 response
units (RU). Move forward with initial kinetics

experiments using this concentration.
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